
Description
This tutorial examines the use of EDVDS to study the controllability of a truck
tractor towing a set of 45-foot highway doubles down a mountain road. The
vehicle is attempting to negotiate a down-hill curve to the right; the maneuver
is further complicated by a substantial super-elevation, a narrow shoulder, and
a near-vertical cliff at the shoulder’s edge. Ultimately, the combination vehicle
leaves the road and rolls over (one question we wish to address in our
simulation analysis is whether the vehicle rolled over before or after it left the
road), tumbling down the steep embankment. This sequence of events serves
to illustrate the sophisticated capabilities of EDVDS.

Like all EDVDS events, the procedure involves the following basic steps:

� Create the vehicle(s)

� Create the environment

� Execute the EDVDS event(s)

� Review the EDVDS output reports

This basic procedure is described in detail in this tutorial.
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Getting Started
As in other tutorials, before we get started with our current tutorial, let’s set the
user options so we’re all starting on the same page.
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To set the initial user options, choose the following from the Options Menu:

� ON: Show Key Results

� OFF: Show Axes

� ON: Show Contacts

� OFF: Show Velocity Vectors

� ON: Show Skidmarks

� OFF: Show Targets

� ON: AutoPosition

� Units equals U.S.

� Render Options:

� Show Humans as Actual

� Show Vehicles as Actual

� Phong Render Method

� Complexity equals Object

� Render Quality equals 5

� Texture Quality equals 1

� Anti-aliasing equals 1

The remaining options will automatically initialize to their default conditions.
We’re now ready to proceed with the tutorial.
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Creating the Vehicles
Now let’s add the vehicles to our case. The tow vehicle is a 1994 Freightliner
FLD-120 conventional tractor; the trailers are both 45-ft semi-trailers. The
second semi-trailer is supported at the front by a tandem-axle converter dolly.

Let’s create the vehicles, starting with the tractor:

� If the Vehicle Editor is not the current editor, choose Vehicle

Mode. The Vehicle Editor is displayed.

� Click Add New Object. The Vehicle Information dialog is

displayed. The Vehicle Information dialog allows the user to

select the basic vehicle attributes according to Type, Make,

Model, Year and Body Style.
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� Using the option buttons, click each button to choose the

following vehicle from the database:

� Type = Truck

� Make = Freightliner

� Model = FLD-120

� Year = 1994

� Body Style = Conventional w/Raised Sleeper

� Click OK to add Freightliner FLD-120 to the Active Vehicles

list.

The Freightliner tractor is displayed in the 3-D viewer, as shown in Figure
5-1 on the following page.

� � �

�����	
� ��� ���	���� �����	��

T
U

T
O

R
IA

L



� � �

����� �����	
� ��� ���	����

������ ��� �		
 ������������ �	
��
� ��
��
���
�� �������� ���
� ���� ����� �
� ���� ����
���������



Next, let’s add the first semi-trailer. We don’t have the exact vehicle, so we’ll
create it from the Generic Vehicle database:

� Click Add New Object. The Vehicle Information dialog is

displayed.

� Using the option buttons, click each button to choose the

following vehicle from the database:

� Type = Trailer

� Make = Generic

� Model = Generic

� Year = Generic

� Body Style = Class 4

The default vehicle name is Generic Class 4. Let’s change it:

� Replace the default name; enter Trailer 1.

� Click OK to add Trailer 1 to the Active Vehicles list.

The 45-ft semi-trailer is displayed in the viewer, as shown in Figure 5-2.
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Now let’s add the second semi-trailer. Again, we don’t have the exact vehicle,
so we’ll create it from the Generic Vehicle database:

� Click Add New Object. The Vehicle Information dialog is

displayed.

� Using the option buttons, click each button to choose the

following vehicle from the database:

� Type = Trailer

� Make = Generic

� Model = Generic

� Year = Generic

� Body Style = Class 4

The default vehicle name is Generic Class 4. Let’s change it:

� Replace the default name; enter Trailer 2.

� Click OK to add Trailer 2 to the Active Vehicles list.

The second semi-trailer is displayed in the viewer, as shown in Figure 5-3,
above.
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Finally, let’s add the converter dolly that supports the front of the second
semi-trailer. Again, we don’t have the exact vehicle, so we’ll create it from the
Generic Vehicle database:

� Click Add New Object. The Vehicle Information dialog is

displayed.

� Using the option buttons, click each button to choose the

following vehicle from the database:

� Type = Dolly

� Make = Generic

� Model = Generic

� Year = Generic

� Body Style = Class 4 Hinged Drawbar

The default vehicle name is Generic Class 4. Let’s change it:

� Replace the default name; enter Trailer 2 Dolly.

� Click OK to add Trailer 2 Dolly to the Active Vehicles list.

The dolly is displayed in the viewer, as shown in Figure 5-4.
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Editing the Vehicles

Our Freightliner is ready to go, with the exception of changing its color.
However, the trailers and dolly require some editing. Let’s begin by editing the
color of the Freightliner tractor:

� Choose Freightliner FLD-120 from the Active Vehicles

drop-down list, making it the current vehicle. The Freightliner

tractor is now displayed in the Vehicle Editor.

� Click on the CG and choose Color. The Vehicle Color dialog is

displayed (see Figure 5-5), showing the vehicle’s current color

(the small black square, or hot spot, in the color wheel) and

intensity (the arrow in the intensity slider). Click on the hot

spot and drag it to the center of the color wheel, making it

white. To dull the color slightly, click on the intensity slider

and drag it towards the center of the slider’s range.
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� When the color is to your liking, click on the Close button in the

upper right-hand corner of the dialog.
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Next, let’s edit the first semi-trailer by adding a geometry file, changing the
weight and editing the time lag in the trailer’s brakes. Let’s begin by adding the
3-D geometry file. A 45 foot van trailer geometry file, appropriately named
TLVdsTutorTrlr45Van.h3d was prepared by EDC and placed in the
/images/vehicles subdirectory. To attach the geometry file to the
trailer, perform the following steps:

� Choose Trailer 1 from the Active Vehicles drop-down list,

making it the current vehicle. Trailer 1 is now displayed in the

3-D Vehicle Viewer.

� Click on the CG, choose Geometry File and select Open. The

Geometry dialog is displayed (see Figure 5-6), and we’re

ready to select a geometry file from the list box.

� Set Files of Type to be HVE Geometry Files (*.h3d).

� Scroll down the list and double-click on

TLVdsTutorTrlr45.h3d.

The new geometry file is applied to the generic trailer (see Figure 5-7, on
the following page).
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Next, let’s change the trailer’s weight:

� Click on the CG and choose Inertias. The Inertias dialog is

displayed (see Figure 5-8), and we’re ready to change the

weight.

� In the Total Weight text field, replace the existing weight,

12,300 lb, with the measured value, 13135 lb.
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� Press OK to update the trailer’s inertial properties.

The first semi-trailer is ready for our EDVDS simulation analysis.
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Let’s change the parameters for the second trailer, starting with the geometry
file:

� Choose Trailer 2 in the Active Vehicles drop-down list,

making it the current vehicle. Trailer 2 is now displayed in the

3-D Vehicle Viewer.

� Click on the CG, choose Geometry File and select Open. The

Geometry dialog is displayed (same as shown earlier in Figure

5-6), and we’re ready to select a geometry file from the list box.

� Set Files of Type to be HVE Geometry Files (*.h3d).

� Scroll down the list and double-click on

TLVdsTutorTrlr45.h3d.

The new geometry file is applied to the generic trailer, and it should look
just like the first trailer (see Figure 5-7). Next, let’s change the trailer’s
weight:

� Click on the CG and choose Inertias. The Inertias dialog is

displayed, as shown in Figure 5-8, and we’re ready to change

the weight.

� In the Total Weight text field, replace the existing weight,

12,300 lb, with the measured value, 13135 lb.

� Press OK to update the trailer’s inertial properties.
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Finally, let’s increase the default lag time in the left rear trailer brake:

� Click on the left rear wheel and choose Brake. The Wheel

Brake dialog is displayed (see Figure 5-9), and we’re ready to

edit the brake characteristics for the left rear wheel.

� In the Time Lag data field, replace the default value, 0.175 sec,

with 0.305 sec.

� Press OK to update the trailer’s brake characteristics for the left

rear wheel position.

The second semi-trailer is now ready for our EDVDS simulation analysis.

Finally, let’s increase the dolly’s drawbar length:

� Choose Trailer 2 Dolly from the Active Vehicles drop-down

list, making it the current vehicle. Trailer 2 Dolly is now

displayed in the 3-D Vehicle Viewer.

� Click on the CG and choose Connections. The Vehicle

Connections dialog is displayed (see Figure 5-10).

� In the Front Connection, x-coordinate data field, replace the

default value, 96.0 in, with 120.0 in.

� Press OK to update the dolly’s drawbar length.
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The dolly is redisplayed with its new drawbar length.
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All the vehicle units are now ready for our simulation study. Using the viewer
controls (thumb wheels and manipulators), rotate and look at each of the
vehicles we’ve created.
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Creating the Environment
Now, let’s add the environment:

� Choose Environment Mode. The Environment Editor is

displayed.

� Click on Add New Object. The Environment Information

dialog is displayed.

� Using the Location Database combo box, choose Hood River,
Oregon, USA. The latitude (45.40.00N), longitude
(121.11.00W) and GMT, hours from the prime meridian (-8.0)
are displayed for the selected location.

� Enter a name for the environment: Rowena Point.

� Enter the date and time of the incident we are studying,

4-30-98 and 1330, respectively.

� Enter the angle from true north to the earth-fixed X axis in our

environment, 180.0 degrees.
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� To add the environment geometry file to our case, click on
Open. The Environment Geometry File Selection dialog is
displayed.

� Choose Files of Type *.h3d. A list of environment geometry
files using the HVE file format is displayed in a list box.

� Double-click on RowenaPoint.h3d to choose the environment

file and remove the dialog.
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� Press OK.

The selected environment is added to our case and displayed in the
Environment Viewer (see Figure 5-11). Use the viewer thumb wheels to view
the scene.
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Saving the Case
Now that we’ve created all the objects (vehicles and environment) for our case,
let’s save the case file.

� Click on the File menu and choose Save. The Save-as File

Selection dialog is displayed.
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� Place the mouse cursor in the Case Title text field and enter

EDVDS Tutorial, Crash at Rowena Point.
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� Place the mouse cursor in the Filename text field and enter

EdvdsTutorial.

� Click SAVE. The current case data are saved in the

hve/supportFiles/case subdirectory.
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Creating the Event
As mentioned at the outset of the tutorial, we are going to simulate the loss of control
of a set of highway doubles while attempting to negotiate a curve. To create the
event, perform the following steps:

� Choose Event Mode. The Event Editor is displayed.

� Click on Add New Object. The Event Information dialog is

displayed.

� Select Freightliner FLD-120, Trailer 1, Trailer 2 Dolly and

Trailer 2 �� ���� ����� from the Active Vehicles list.
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� Select EDVDS from the Calculation Method options list.

� Enter a name for the event, Controllability on

Grade.
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� Press OK to display the event editor.

Now, we’re ready to set up the event.

� Using the Event Editor dialog, select Freightliner

Conventional from the Event Humans & Vehicles list, then

choose Edit from the menu bar, select Position/Velocity and

click Initial. The complete combination vehicle is displayed in

the environment, with the Freightliner’s CG located at the

earth-fixed X,Y origin, as shown in Figure 5-12. The entire

vehicle is resting on the inclined surface with the trailers and

dollys connected at a zero articulation angle.
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Our EDVDS Tutorial provides us with a great opportunity to thoroughly
explore the subject of positioning vehicles in a 3-D environment. We face the
following challenges:

� First, we don’t know the coordinates of the desired initial position,
so we can’t simply enter them in the Position/Velocity dialog.

� We have a complex, 3-dimensional surface, so placing the vehicles
in a near-equilibrium position could take a lot of time and
patience.

� We have a combination vehicle with four individual units (tow
vehicle two trailers and a dolly) and a total of 18 wheels to
position on the surface, so positioning each individual vehicle
wheel could take even more time and patience.

Fortunately, HVE’s AutoPosition feature greatly simplifies the task of
positioning vehicles in a complex, 3-dimensional environment:

� Click on the Freightliner’s X-Y manipulator (see Figure 5-12),

wait for it to turn bright yellow (indicating it has been

selected), and drag slowly drag the vehicle down towards the

road.

� ����� �� ������ ��� <6: 
����	������ ��� ������ 
	�� ��

�� $��% 
���� �� ��������� �� ��� ����������� ����� �� ���

	���� ����� ������ �� ��� ������ .��� &��	�� =623/�

� ����� >� �	�� �� %��� ��� 
�	�� �	���� ���������

����� ��	 ���� ��� 
����	�������

� ����� ��� ? ����������� ��� ��� ��� ������� ��� ����

������� ��� �	��
�������� �����
���� 	���� 
����

'	��$������� ����	�� �������

� ����� '� ��	 ���� ��� ��� �������� ��� �������� ������

��� ��� ������� ���� ��� ������

� ����� '�@	�� ��� ������ �� �������� �������� ���

�������� ���% .	�� ������ ��� ��	
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������� �� ��� �������� ������

� Click the yaw manipulator and rotate the tow vehicle until it is

aligned with the road, approximately 90 degrees.

� Again, click on the X-Y manipulator and drag the vehicle up

the hill, intermittently clicking on the yaw manipulator to keep

the entire trailer-train on the road.

� Ultimately, the tow vehicle should be placed at X=445 ft,

Y=-945 ft and Yaw=65 deg as shown in Figure 5-13.

� Click the Velocity Is Assigned checkbox. Enter the initial

velocity, 55 mph.
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After the Freightliner tractor is positioned (see Figure 5-13), we need to
position the trailers and dolly:

� Click on Trailer 1. The orientation manipulator is displayed

and its initial orientation is displayed in the Position/Velocity

dialog, as shown in Figure 5-14

� ����� ��� <�:�? ����������� ��� ��� ��������� ����	��

��� ������� �� ��������� �� � ��� �������� ��	�� �� ��� ��

<�:�? ������� �� ������
�

� ����� >���	�� ��� ������� �� �������� �� � ��� ��������

��� ������ ����� ��� �����	������ ������ �������� �� ���

��� �������� ��� �����	�� .�����6�� ��/ �������

Trailer 1’s position is acceptable, so let’s position the dolly and second trailer:

� Click on Trailer 2 Dolly (it’s easiest to click on its wheels). The

orientation manipulator is displayed and its initial orientation

is displayed in the Position/Velocity dialog.

� Click and drag yellow yaw manipulator until the dolly’s initial

yaw articulation angle is about -2 degrees, as shown in Figure

5-15.

� Click on Trailer 2. The orientation manipulator is displayed

and its initial orientation is displayed in the Position/Velocity

dialog.

� ClickanddragyellowyawmanipulatoruntilTrailer2‘s initialyaw

articulation angle is about -2 degrees, as shown in Figure 5-16.

The vehicles’ initial conditions are now established. Let’s enter a payload for
each trailer:

� Using the Event viewer, click on Trailer 1. The orientation

manipulator is displayed and its initial orientation is displayed

in the Position/Velocity dialog.

� Click on the Edit menu and choose Payload. The Payload

dialog for Trailer 1 is displayed (see Figure 5-17).

� Click on the Payload Exists check box. The data fields in the

Payload dialog are enabled.

� Enter a weight for the payload; enter 25000 lb.

� Enter a roll moment of inertia; enter 200000 lb-sec
�
-in.

� Enter a pitch moment of inertia; enter 1500000 lb-sec
�
-in..

� Enter a yaw moment of inertia; enter 1500000 lb-sec
�
-in..

� Press OK to accept the payload data for Trailer 1.

� � ��
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Next, let’s add a payload to the second trailer:

� Using the Event viewer, click on Trailer 2. The orientation

manipulator is displayed and its initial orientation is displayed

in the Position/Velocity dialog.

� Click on the Edit menu and choose Payload. The Payload

dialog for Trailer 2 is displayed (refer to the dialog shown

earlier in Figure 5-17).

� Click on the Payload Exists check box. The data fields in the

Payload dialog are enabled.

� Enter a weight for the payload; enter 25000 lb.

� Enter a roll moment of inertia; enter 200000 lb-sec
�
-in.

� Enter a pitch moment of inertia; enter 1500000 lb-sec
�
-in..

� Enter a yaw moment of inertia; enter 1500000 lb-sec
�
-in..

� Press OK to accept the payload data for Trailer 1.
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Next, let’s enter the driver controls. We’ll start with the Freightliner’s steering
table. To enter the steer angles, perform the following steps:

� Click on the Edit Menu, select Driver Controls and choose

Steering. The Steering Table dialog is displayed.

� Click on the Table Is option list and choose the At Steering

Wheel option.

� Enter the steer angles for the Freightliner Tractor, as shown in

Table 5-1 and Figure 5-18.

� Press OK to accept the steering table.

Next we enter the braking table:

� Click on the Edit Menu, select Driver Controls and choose

Brakes. The Brake Table dialog is displayed.

� Click on the Table Is option list and choose the Pedal Force

option (for air brakes, Pedal Force equals Treadle Pressure).

� Enter the values shown in Table 5-2 and Figure 5-19.

� Press OK to accept the brake table.
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Since our goal for this event is to see what causes the vehicle to roll over, let’s
look at some Key Results during execution:

� If Key Results windows are not displayed, choose Show Key

Results from the Options menu.

� Drag the Key Results windows to a convenient location, where

they do not block the view but still allow us access to the

viewer thumb wheel controls (in case we want to change the

view).

� Click on Select Variables in the Freightliner FLD-120 Key

Results window. The Variable Selection dialog for

Freightliner FLD-120 is displayed.

Let’s add Tire Fz’ to the Freightliner’s Key Results window:

� Click Tires and choose Axle 1, Right, Outer from the cascade

menus. The Variable Selection list for the right front tire is

displayed (see Figure 5-20, above).

� Select Fz’ from the list.
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� Click Tires and choose Axle 1, Left, Outer from the cascade

menus. The Variable Selection list for the Left front tire is

displayed; select Fz’ from the list.

� Repeat the above steps for Freightliner’s rear tandem axles,

choosing F�‘ for Axle 2 and Axle 3.

� Press OK to include the new variables in the Key Results

dialog.

Next, let’s add the vertical tire forces for the trailers:

� Click on Select Variables in the Trailer 1 Key Results

window. The Variable Selection dialog for Trailer 1 is

displayed.

Let’s add Tire Fz’ to the trailer’s Key Results window:

� Click Tires and choose Axle 1, Right, Outer from the cascade

menus. The Variable Selection list for the front tandem axle,

right side, is displayed; select Fz’ from the list.

� Repeat the above steps for trailers remaining tires.

� Press OK to display the new variables in the Key Results

dialog.

Using the same procedure, proceed to add any other Key Results of interest to
you.
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Now, we’re ready to execute the event.

� Using the Event Controller, click Play to execute the event.

Allow the event to run until completion.

� ����� ����� ��� ����� �� � ��	����� ����� ��� �	�����

���	��� .���������� ��� ��������� '����������� ��� &�

���	��/ �� ��� A�� B��	��� ��������

The EDVDS event is shown at time, t =3.5 seconds in Figure 5-21, just as
the vehicle is leaving the road.

� ���� >� ��������� ��� �������	�� ����� �������� �����

������ &7� �� ��� A�� B��	��� �������� �� ��� ��� �� ���

��� ��������� ����� ����� ����� ���� ������� �� ����� �� ���

�������� ���	� ��� &7�

We have now completed the event.
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Viewing Results
Now that we have produced our EDVDS simulations, let’s take a detailed look
at the results. The Playback Editor is used for reviewing and printing reports
for each event in the current case, as well as for producing video output.

EDVDS produces the following reports:

� �������� � A list of messages produced by the current run

� ����	�
�����
�� �A table of initial and final positions and velocities

� ������� ���� � A series of tables containing the vehicle data used by

EDVDS

� ��
���� ���� � A table containing program control information

� �������� ������ � A table containing user-selected, time-dependent

simulation results

� �������
�� ��������

 � A 3-D visualization of the event, displayed

at a user-selectable time interval

To view the output reports, we need to be in Playback mode:

� Choose Playback Mode. The Playback Editor is displayed.

� � �!
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Report Windows

The reports listed on the previous page are displayed by selecting Report
Windows. Each Report Window contains an individual report.

To view the reports produced by the EDVDS, Controllability on Grade event,
perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed, as shown in Figure 5-22, and includes a list

of the active events (EDVDS, Controllability on Grade is the

only event in this tutorial). The Report Window Information

dialog also includes the user-editable Window Name text field

and Selected Output option list.

� Select EDVDS, Controllability on Grade from the Active

Events list.

� Click on the Selected Output option list and choose any of the

available reports.

� Press OK to display the report.

The selected report will be displayed in a resizable window. The following
pages illustrate the reports produced for the EDVDS, Controllability on Grade
event.
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Messages

EDVDS produces a number of messages, depending on the outcome of the
event. For a complete list and explanation of these messages, see Chapter 6.

To view the Messages report produced by the EDVDS, Controllability on
Grade event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDVDS, Controllability on Grade from the Active

Events list.

� Click on the Selected Output option list and choose Messages.

� Press OK.

The Messages report is displayed for the EDVDS, Controllability on Grade
event, as shown in Figure 5-23.

Accident History

The Accident History report displays the time and total distance traveled, as
well as position and velocity at the start and end of the run.

To view the Accident History report for the EDVDS, Controllability on Grade
event, perform the following steps:

� Click Add New Object. The Report Window Information
dialog is displayed.

� Select EDVDS, Controllability on Grade from the Active Events

list.

� Click on the Selected Output option list and choose Accident

History.

� Press OK.

The Accident History report is displayed for the EDVDS, Controllability on
Grade event, as shown in Figure 5-24, on the following page.
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Vehicle Data

The Vehicle Data report for EDVDS displays vehicle data, tire data and driver
control tables for each vehicle in the event.

� ����� ��� ������� !��� ������ �� ��� ����� �� ��� �� ���

������� C�� ��� ������ ���� �� ���� ��� ������ �������

To view the Vehicle Data report for the EDVDS, Controllability on Grade
event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDVDS, Controllability on Grade from the Active

Events list.

� Click on the Selected Output option list and choose Vehicle

Data.

� Press OK.

A portion of the Vehicle Data report is displayed for EDVDS, Controllability
on Grade is shown in Figure 5-25 on the following three pages.
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Program Data

The Program Data report contains the simulation controls used by the EDVDS
event.

To view the Program Data report for the EDVDS, Controllability on Grade
event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDVDS, Controllability on Grade from the Active

Events list.

� Click on the Selected Output option list and choose Program

Data.

� Press OK.

The Program Data report is displayed for the EDVDS, Controllability on
Grade event, as shown in Figure 5-26.
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Variable Output

To view the Variable Output report for the EDVDS, Controllability on Grade
event, perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDVDS, Controllability on Grade from the Active

Events list.

� Click on the Selected Output option list and choose Variable

Output.

� Press OK.

The Variable Output report is displayed for the EDVDS, Controllability on
Grade event. The table is initially empty, so the next step is to select the
time-dependent results we wish to display in the table.

Variable Selection

The purpose of our event is to determine the vehicle’s propensity for
rollover, so let’s display the velocities, accelerations and vertical tire forces
from the Variable Selection dialog.

� Click on Select Variables in the Variable Output window. The

Variable Selection dialog is displayed, allowing us to choose

variables to display in the Variable Output table.

First, let’s add the velocities and accelerations. These variable belong to the
Kinematics output group; this is the default group, and the Kinematics
Variables list for Freightliner FLD-120 tractor is already displayed.

� Select V-tot, Fwd Acc and Lat Acc from the list.

Next, let’s add the vertical wheel loads:

� Click Tires and choose Axle 1, Right, Outer from the cascade

menus. The Variable Selection list for the right front tire is

displayed (see Figure 5-27).

� Select Fz’ from the list.

� Click Tires and choose Axle 1, Left, Outer from the cascade

menus. The Variable Selection list for the Left front tire is

displayed; select Fz’ from the list.

� Repeat the above steps for the Freightliner’s rear tandem axles,

choosing F�‘ for Axle 2 and Axle 3.
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Next, let’s add the vertical tire forces for the semi-trailer:

� Click on the Object Name option list and choose Trailer 1. The

Kinematics Variables list for the first semi-trailer is displayed.

� Click Tires and choose Axle 1, Right, Outer from the cascade

menus. The Variable Selection list for the front tandem axle,

right side, is displayed; select Fz’ from the list.

� Repeat the above steps for trailer’s remaining tires.

� Press OK.

The Variable Output report for the EDVDS, Controllability on Grade event
now includes tow vehicle velocity and acceleration and vertical tire loads
for each wheel location, as shown in Figure 5-28.
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Trajectory Simulation

Finally, let’s display a trajectory simulation for this event. To view the
Trajectory Simulation for the EDVDS, Controllability on Grade event,
perform the following steps:

� Click Add New Object. The Report Window Information

dialog is displayed.

� Select EDVDS, Controllability on Grade from the Active

Events list.

� Click on the Selected Output option list and choose Trajectory

Simulation.

� Press OK.

The Trajectory Simulation viewer is displayed for the EDVDS, Controllability
on Grade event (see Figure 5-29). The tractor and trailer are shown at their
initial positions.

To visualize the motion as the tractor-trailer attempts to negotiate the
down-hill curve, perform the following steps:

� Click Play (single right-arrow). The simulation begins and is

displayed at the current Playback output interval.

� Click Pause. The simulation stops.

� Click Reverse (single left-arrow). The simulation plays in

reverse.

� Click Pause. The simulation stops.

� Click Rewind (left arrow with bar). The simulation returns to

the start.

� Click Advance to End (right arrow with bar) the simulation

advances to the end of the run.
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Printing

The final step is to print the above reports. Printing reports is simple. All you do
is choose a report and print it. For example:

� Click on the dialog header of the Accident History - EDVDS,

Controllability on Grade report. Your selection is highlighted

and the Accident History window pops to the top of the display

(if it isn’t there already), indicating it is the current window.

� Click on the File menu and choose Print. The Print dialog is

displayed, allowing the user to select from several available

print options.
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� Press OK. The Accident History output report is printed on the

system printer.

That’s all there is to it! You can print any other report using the same two steps
described above.
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